# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
<td>2</td>
</tr>
<tr>
<td>Getting Started (Quick Start Guide)</td>
<td>4</td>
</tr>
<tr>
<td>Key Pedagogic Topics</td>
<td>5</td>
</tr>
<tr>
<td>Preface</td>
<td>6</td>
</tr>
<tr>
<td>Starting Records Manager</td>
<td>7</td>
</tr>
<tr>
<td>Locating Records Manager</td>
<td>7</td>
</tr>
<tr>
<td>Passwords</td>
<td>7</td>
</tr>
<tr>
<td>Registration</td>
<td>8</td>
</tr>
<tr>
<td>Classes</td>
<td>9</td>
</tr>
<tr>
<td>Adding or Editing a Class</td>
<td>9</td>
</tr>
<tr>
<td>Deleting a Class</td>
<td>13</td>
</tr>
<tr>
<td>Selecting a Class</td>
<td>13</td>
</tr>
<tr>
<td>Students</td>
<td>14</td>
</tr>
<tr>
<td>Adding a Student</td>
<td>14</td>
</tr>
<tr>
<td>Setting Expiration Dates and Deactivating Students within a Class</td>
<td>15</td>
</tr>
<tr>
<td>Disabling Student Access to Home-Study</td>
<td>15</td>
</tr>
<tr>
<td>(Online Version)</td>
<td>15</td>
</tr>
<tr>
<td>Transferring a Student</td>
<td>15</td>
</tr>
<tr>
<td>Deleting a Student</td>
<td>15</td>
</tr>
<tr>
<td>Create Generic Students (Online Version)</td>
<td>15</td>
</tr>
<tr>
<td>Editing Student Data &amp; Study Paths</td>
<td>16</td>
</tr>
<tr>
<td>Unlocking or Locking Tests and Lessons</td>
<td>16</td>
</tr>
<tr>
<td>Printing a List of Students</td>
<td>16</td>
</tr>
<tr>
<td>Student Records</td>
<td>17</td>
</tr>
<tr>
<td>Viewing Student Records by Class and Course</td>
<td>17</td>
</tr>
<tr>
<td>Understanding and Sorting Student Records</td>
<td>17</td>
</tr>
<tr>
<td>Switching Between Courses</td>
<td>18</td>
</tr>
<tr>
<td>Understanding and Sorting Placement Test</td>
<td>19</td>
</tr>
<tr>
<td>Records</td>
<td>19</td>
</tr>
<tr>
<td>Intelligent Tutor</td>
<td>20</td>
</tr>
<tr>
<td>Viewing Individual Student Records by Lesson</td>
<td>21</td>
</tr>
<tr>
<td>Study Record Details</td>
<td>21</td>
</tr>
<tr>
<td>Locked &amp; Unlocked Lessons</td>
<td>22</td>
</tr>
<tr>
<td>Viewing Individual Student Records by Date</td>
<td>22</td>
</tr>
<tr>
<td>Printing Student Records</td>
<td>23</td>
</tr>
<tr>
<td>Viewing Study Records Offline using the</td>
<td>23</td>
</tr>
<tr>
<td>Internet Records Manager</td>
<td>23</td>
</tr>
<tr>
<td>Sync All Student Records Now (Online Version)</td>
<td>23</td>
</tr>
<tr>
<td>Setting Up Automatic Synchronization of</td>
<td>23</td>
</tr>
<tr>
<td>Local Records to Internet Records</td>
<td>23</td>
</tr>
<tr>
<td>Using the Find Feature (Online Version)</td>
<td>24</td>
</tr>
<tr>
<td>Extension Activities</td>
<td>24</td>
</tr>
<tr>
<td>Study Scores (SS) and Weighted Study Scores</td>
<td>25</td>
</tr>
<tr>
<td>(WSS)</td>
<td></td>
</tr>
<tr>
<td>Import-Export Tools</td>
<td>27</td>
</tr>
<tr>
<td>Import Student Names</td>
<td>27</td>
</tr>
<tr>
<td>Export Student Names</td>
<td>27</td>
</tr>
<tr>
<td>Export Student Data</td>
<td>27</td>
</tr>
<tr>
<td>Export This Screen</td>
<td>27</td>
</tr>
<tr>
<td>Administrator Options</td>
<td>28</td>
</tr>
<tr>
<td>Records Manager Options</td>
<td>28</td>
</tr>
<tr>
<td>Set Begin/End Date</td>
<td>28</td>
</tr>
<tr>
<td>View Active Students</td>
<td>28</td>
</tr>
<tr>
<td>Change Administrator Password</td>
<td>28</td>
</tr>
<tr>
<td>Backup Student Data</td>
<td>28</td>
</tr>
</tbody>
</table>
Getting Started (Quick Start Guide)

STEP 1) Teacher:
- Watch the **Introducing The Records Manager** video [Here](#)
- Double-click the ‘Records Manager’ icon on your desktop [More Details](#)
- Click ‘Add’ to create a new class. Fill in the class information [More Details](#)
- Highlight the new class and click on ‘Select’
- Click ‘Add’ to create a new student. Fill in the student information. [More Details](#)
- Exit the RM

STEP 2) Student:
- Double-click the ‘DynEd Courseware’ icon on your desktop
- Select the ‘Placement Test’
- Select the appropriate Placement Test
- Take the Practice Test to get familiar with the test
- Take Part-1 of the Placement Test. If your score is high enough, take Part-2.
- Select a course that has been unlocked by the Placement Manager
- Take the Confirmation Mastery Test
- Study any lesson in that course
- When the student has studied enough, they will be asked to take a Mastery Test
- When they pass the Mastery Test, the next lessons/courses will unlock

STEP 3) Teacher:
- Double-click the ‘Records Manager’ icon on your desktop [More Details](#)
- Select your class
- Notice the student’s Weighted Study Score -- look for students with low scores [More Details](#)
- Highlight the student and click the Tutor button and review any issues with the student [More Details](#)

STEP 4) Administrator:
- Double-click the ‘Records Manager’ icon on your desktop
- Look at the list of classes
- Notice the student’s Weighted Study Score – look for classes with low scores [More Details](#)
- Review the student’s study habits with the teachers [More Details](#)
Key Pedagogic Topics

(click for more information)

- **Path Manager**  See Video
  - The Study Path Manager
  - The Placement Manager
  - The Progress Manager

- **Locking/Unlocking Lessons and Tests**

- **The Extension Activities**

- **Tracking Performance**
  - The Tutor button
  - Study Scores and Weighted Study Scores
  - The Completion Percentage
  - The Shuffler Level
  - Class and Student Study Reports
Preface

The Records Manager manages study records for all DynEd and Powered-by-DynEd courses. It is required for Mastery Tests, locking and unlocking lessons, and for monitoring study activities for classes and individual students.

For additional information, please see the Appendices of this manual and the following manuals, which are included on the DynEd Installation Disc CD-ROM:

- **DynEd Network Installation Guide** — Installation of networked courseware
- **DynEd User’s Guide** - Installation and startup information for DynEd courseware
- **Testing and Evaluation Guides (for specific courses)** - Guidelines for using the built-in testing features of DynEd courses

*For most DynEd courses, Teacher’s Guides are available. To access them from within the Records Manager, first go in to a class, then go to the Help pull-down menu, and then to Documentation. You may also access them online at [www.dyned.com/dyned/eng/guides.html](http://www.dyned.com/dyned/eng/guides.html). These guides save time and help teachers integrate DynEd courseware into their teaching.*
Starting Records Manager

Locating *Records Manager*

<table>
<thead>
<tr>
<th></th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image1.png" alt="Records Manager" /> or <img src="image2.png" alt="Records Manager.exe" /></td>
<td><img src="image3.png" alt="Records Manager" /></td>
</tr>
</tbody>
</table>

*The Records Manager* is installed automatically as part of all DynEd courses. However, it cannot be used unless it is licensed and then registered.

**Local Records Manager Installation:**

To access the *Records Manager*, go to the DynEd folder where you installed the course. Here you will see the *Records Manager* icon, as shown above. Double-click the icon to launch the *Records Manager* application.

**Internet Records Manager Installation:**

To access the *Internet Records Manager*, go to the DynEd folder where you installed the course. Double-click the *Records Manager* icon to launch the *Internet Records Manager*. Type your Login and Password information to gain access to the list of classes or study groups.

*For network installations, the network administrator should put a shortcut or alias on each teacher’s desktop for easy access.*

**Passwords**

When starting the *Records Manager*, you will see the Class Selection screen, which is a list of classes. To *Add* or *Edit* a class, see [Adding or Editing a Class](#).

Once a class is selected, you will be asked for a password. If no password has been set for the class, click *OK*. To set a password, highlight the class name from the Class Selection screen, and click the *Edit* button. Enter your password where it says *Teacher Password*, and enter it again where it says *Verify Password*. From then on, that password will be required to see and manage the records. Please note that the Administrator password can gain access to any class. We recommend the use of a Teacher Password to prevent student access to the *Records Manager*. 
Registration

The Records Manager must be registered before it can be used. For Internet users, your Records Manager is probably already registered. To register any DynEd product you can follow the Registration instructions in the Users Guide (which requires the use of the DynEd Installation Disc) or, if you have already installed products, you can run the Records Manager, go to the Options pull-down menu, and choose License Management. You will then see the License Management Screen.

To use the License Management Screen to register your Records Manager (or any DynEd product which has been installed but isn’t yet registered), or to add and register a new license:

1. In the upper left hand box, highlight the Installation Code of the installed product that you wish to register, or click on New Installation Code to enter the Installation Code for a new license.

2. If the computer where you are doing the installation is connected to the Internet, click Register Online, accept the License Agreement, and fill-in the requested information. Click on Register Now, and you’re done.

   • If you have internet access on a different machine, go to: http://www.dyned.com/register

   Enter your Confirmation Code. You will get back a Registration Code. Enter the registration code on the screen, and click Submit.

   • If you do not have Internet access, use one of the other methods listed on your License Certificate to get a Registration Code.

   Note: You can use the standard copy and paste commands for entering the Confirmation and Registration Codes. For Windows, Ctrl+C (copy) and Ctrl+V (paste), and for Macintosh, Command+C (copy) and Command+V (paste).
Classes

When any DynEd course is installed, all students are organized into a single, default class. With a registered Records Manager (see Registration), it is possible to set up multiple classes, each specified by a Class Name and a Teacher’s Name. New classes, teachers, and students may be added at any time.

Adding or Editing a Class

At the bottom of the List of Classes Screen, the Add or Edit (requires password) buttons bring up the following Class Information Screen which allows you to set up options for tests, view licensed courses, set student permissions and support features, and modify study time.

- **Class Name** - Name given to this class. Example: “English 1A 3:00 pm.”
- **Teacher Name** - Enter or edit the name of the teacher associated with this class.
- **Teacher E-mail** - Enter or edit the Teacher’s e-mail address. (Optional)
- **Teacher Password** - **** (Enter or edit the Teacher’s password.) (Optional but recommended)
- **Verify Password** - **** (Re-enter the Teacher’s password.) (Optional but recommended)

Note: Teacher Passwords must contain at least six characters, including one number and one letter.

Path Manager

The Path Manager sets up a student’s study path, from starting the Placement Test and Mastery Test, to opening up subsequent units and courses as the student continues to study. Teachers do not have to lock and unlock units or courses manually in the Records Manager, which will save time and provide guided study for the student. By default, the Path Manager is (On) for new classes. **Note:** If an existing student has studied for over 1 hour, the Placement Manager will not be activated for this student (the student will not be asked to take the Placement Test).
Path Manager (On):

- **Placement Manager** - When selected (default), the Placement Manager commits new students to take a Placement Test and Mastery Test (if installed) prior to entering or studying the licensed courseware. Once the appropriate Placement Test is completed successfully, a list of unlocked courses will be shown. When entering a course for the first time, students may be directed to take a Mastery Test to confirm their Placement Level. The results of these tests are then used to place students into level-appropriate units within the courses.

- **Study Path Manager** – When selected (default), the Study Path Manager unlocks appropriate units, lessons and courses automatically. The next units will unlock when two conditions are met:
  - Completion Percentage for the current unit(s) exceeds 50%. (The Completion Percentage may also unlock additional courses as students improve.)
  - Mastery Test scores for certain previous units are passed with a score of 85 or above.

  *Note:* If a teacher or Administrator unlocks additional lessons, the Study Path Manager will not override the changes.

- **Progress Manager** - When selected (default), the Progress Manager generates reports for teachers and administrators. These reports give detailed information about the progress of students as measured by a series of Mastery Tests and by indicating the number of lessons and learning steps completed for each student in the period of time specified. These reports are especially useful for schools that need to demonstrate usage and progress in a period of time that is less than would be required to use entry and exit Placement Tests.

  The Progress Manager measures achievement by having students take tests immediately upon entering a course, and then taking the same or similar tests at a later date to show progress.

  For more information please go to the DynEd website:

  Progress Manager
  Student and Class Reports

Path Manager (Off):

- **Lock all Lessons for New Students** - When selected, all lessons are automatically locked to prevent premature viewing of the lessons. The teacher must unlock the lessons before students can access them. When unlocking lessons, remember not to unlock the Mastery Tests, as they should remain locked until the students are ready to take them.

- **Lock All Mastery Tests for New Students** - When selected, all tests are automatically locked to prevent premature viewing of the test. The teacher must unlock the Mastery Tests before students can access them. This is the default setting.

- **Auto-Relock Mastery Tests After Use** - A test is automatically locked after it has been taken to prevent re-taking. This is the default setting.

Options for Tests:

- **Auto-Unlock Mastery Tests After Students Attains 80% Complete** - If the Mastery Tests are being used in a less-structured situation, such as in a self-access lab, the teacher or Administrator may prefer to set the program to automatically unlock the Mastery Tests once the student has achieved a predetermined Completion Percentage score in the lessons related to that test. Generally, students should attain an 80% level or more before taking the Mastery Tests.

- **Auto Re-Unlock Mastery Tests After X Days** - A Mastery Test is automatically unlocked for a second time only if the initial score was less than 85. Set X for the number of days between tests.
Courses
The Courses tab displays the list of licensed courses for a class. Deactivated courses may not be accessed by the class. To activate or deactivate a course, highlight it and press the appropriate button.

Students
Student Permissions and Student Support Features can be modified here. It is generally recommended that these settings remain at their default. These options are useful in situations where students are required to self-register (such as self-access labs).

Student Permissions:
- **Allow students to Add, Edit or Delete** - If these options are enabled, students can enter their own names and passwords when they run the course. This can be useful for self-access labs where it may not be convenient to pre-register all students. Please note that when a new class is added, the default setting is to disable the Add, Edit, and Delete functions. However, if a course is run before classes have been set up for it, the Records Manager will create a default class to store the records. In the default class, the Add, Edit and Delete functions are all enabled, and the name of the class will be: “Class Name.” **Note:** The only option available for Internet Records users is the Edit function.

- **Allow students to use Passwords** - If this option is checked, students will be able to use passwords when running the course. The default is to allow students to use passwords.

**Note:** It is generally recommended that the Delete function be disabled. This prevents students from accidentally deleting each other’s names and study records.
Enable These Student Support Features in the Courseware:

- **Support Language** - Checking this box enables language translation support, including Help Screens. The default is to have translation support enabled. The box should be unchecked if the teacher wants all support to be English-only.

- **Tutor** - If this option is checked, students will be able to see suggested study tips and study scores via the Intelligent Tutor.

- **Prescriptive Study** - Enabled by default, Prescriptive Study adjusts student study in all DynEd courseware in the following ways:
  - The *Fast Forward* button is disabled (except during Presentation lessons).
  - Both the *ABC* button and the *Translation* button (Support Language) are disabled unless the *Repeat* button is pressed first. Subsequent use of the *ABC* or *Translation* buttons will require students to click the Repeat button before utilizing these features.
  - Students will be unable to enter the same non-presentation lesson more than twice in succession during a study session.

**Options**

The Recommended Study Time slider allows the teacher to adjust the calculation of the student’s Completion Percentage value. Moving the slider toward *Less* makes it easier for the student to reach a high Completion Percentage value and moving it toward *More* makes it more difficult. See Adjusting the Completion Percentage for more information.

**Note:** Internet Records users can also set a Class Expiration Date for each class.
Deleting a Class
At the bottom of the Class Selection Screen, the *Delete* button will remove a class and all its records. Be careful not to accidentally delete a class. Once a class is deleted, all student records for that class are erased. For this reason, Administrators should regularly back up Study Records.

Selecting a Class
You will see the Class Selection Screen after starting the *Records Manager*. This allows you to *highlight* a class. Once a class is highlighted, you may edit it, delete it, or select it to see the Student Records.

*Note:* The Internet Records version also features the number of students as well as the date of last access for each class.
After selecting a class, (by either double-clicking on its name or by highlighting it and clicking the Select button), you will be asked for a password. If no password has been set, click OK. If a password has been set, please type in the password, click OK, and you will see the Class Records screen.

This screen shows the list of students enrolled in the class. The class name, teacher name, and the number of students in the class are shown at the top of the screen. If more than one course has been installed, you can see the records for each course by using the pop-up menu to switch from one course to another. For each course, the number of students in the class who have studied that course is indicated. To select a different course from the one shown, highlight the name of the course you want.

Adding a Student

To add a student to the class, click the Add button at the bottom of the screen. This brings up a Set-up Screen, where you can enter the student’s information and lock/unlock lessons and tests for that student.

- **Student Name** - Enter the name (or ID number) here. The name must be unique within this class.
- **Password / Verify Password** - Enter a password. These fields are only accessible if the Passwords option was not disabled when setting up the class. See Adding or Editing a Class. Leave the student Password field blank if you want students to choose their own passwords when they start using the
course. In order for students to choose their own passwords, you must ensure that Edit is enabled in the class set-up for that class. If you type in a student Password, you must type the password again in the Verify Password field to ensure that it has been typed in correctly.

**Note:** If you want to enable Passwords, go back to the Class Selection screen and Edit the Class set-up so that the Password option is **not** checked.

- **Student E-mail** - Enter the student's e-mail address.
- **Disable / Lock / Unlock Lessons for This Student** - Allows lessons and tests to be disabled, locked or unlocked. This is important for setting a study path for the student. To lock or unlock lessons or tests for an entire class or group, see Editing Student Data & Study Paths.
  - **Disable**: Lock the lesson in a way that the Study Path Manager will never unlock it.
  - **Lock**: Lock the lesson in a way that the Study Path Manager can unlock it at the appropriate time.
  - **Unlock**: Unlock the lesson

Lessons are displayed in a list, with lower levels displayed when you click on the plus sign (Windows) or arrow (Macintosh). Items can be selected within the list by single clicking on them. To **highlight** a series of items, hold down the **SHIFT** key and click a second time on the last item in the series. To select multiple items that are not in a continuous series, hold down the **Ctrl** (Windows) or **COMMAND** (Macintosh) key while clicking on each item.

The lessons that are selected will be locked or unlocked when the **Lock** or **Unlock** button is pressed. Selecting a high-level item that has other sub-items below it in the hierarchy (that is, one that has a plus sign or arrow) will cause all sub-items below it to be locked or unlocked when the **Lock** or **Unlock** button is pressed. This is true even if the sub-items below are not currently visible. **Be careful not to accidentally unlock Mastery Tests.**

- **Setting Expiration Dates and Deactivating Students within a Class** This option allows an expiration date (Online Version) to be set for each student, prohibiting a student from logging in after that date. At any time, a student within a class may be deactivated by checking the Deactivate box. A student who has been deactivated or whose study has expired will not be billed even though their name remains in the class list and the class remains active.

- **Disabling Student Access to Home-Study (Online Version)** Home-Study can be disabled for individual students.

**Transferring a Student**

To transfer students and their complete study records from one class to another, **highlight** the student’s name (or group of students), and then go to the **Options** pull-down menu at the top of the screen. Highlight the **Transfer Student** option and the name of the destination class. A dialog box will allow you to confirm the destination class. If correct, click on **OK** and the records will be transferred. (Note: This operation requires the use of the passwords for both Classes.)

**Deleting a Student**

To delete a student from a class, select the name and click on **Delete**. Once a student is deleted, their study records are permanently erased, so be careful.

**Create Generic Students (Online Version)**

This utility allows teachers to generate a group of generic students, each with a randomized alphabetical 8-letter code or ‘name.’ Students (or teacher) log-in with this code and edit that code to the student’s name or ID number, along with other information. This utility is particularly useful in setting up class records for a large number of students in advance of knowing their names and other information. It is possible to generate 30 generic students at a time, with a maximum of 1,000 students per class.

To access this function, simply start the Internet Records Manager and select **Create Generic Students**… from the **Options** menu.
Editing Student Data & Study Paths

To *Edit* the student set-up data (including password, e-mail address, and the locking or unlocking of lessons and tests) go to the Class List and select the student or group of students you wish to edit. Click on the *Edit* button. If a single student is selected, then the edit options are the same as those under *Adding a Student*, including the password and e-mail address. However, if more than one student is selected, then the edit screen will only allow the adjustment of lock and unlock settings for lessons and tests. These settings will be applied to *all* of the selected students.

![Student Information](image)

To adjust the locked/unlocked lesson settings for an *entire class*, choose *Select All* from the pull-down *Edit* menu at the top of the screen to highlight all of the students. Then click on the *Edit* button at the bottom of the screen. Specific Lessons or *Mastery Tests* may then be locked or unlocked for the entire class.

Unlocking or Locking Tests and Lessons

Highlight the student(s) you wish to edit. Click *Edit*. Select the test or lesson you wish to lock or unlock. Click one of the buttons at the bottom of the screen. Then click OK.

- **Unlock**: Unlocks the lesson
- **Lock**: Locks the lesson in a way that the Study Path Manager can unlock it at the appropriate time.
- **Disable**: Locks the lesson in a way that the Study Path Manager will never unlock it.

To determine when the next Mastery Test or Lesson will auto-unlock, perform the following:

- Highlight a single student and click the Tutor button.
- Click the More Detail button and scroll down to the bottom of the page.

Some messages only appear if the Study Path Manager is turned on. For example, teachers may see information such as:

> ‘Module 7 > Epidemic’ will not be unlocked by the Study Path Manager until you raise the Mastery Test score on ‘Module 6 > Life Experience > Mastery Test’ from 65 to over 85.

Printing a List of Students

Selecting *Print* from the *File* menu brings up a standard print dialog box. It will print a list of students along with their total study time and number of study sessions.

To print a partial list of students, highlight the names of the students whose records should be printed *before* selecting *Print*. You will be asked to confirm whether you want to print all students or only the students selected.
Student Records

Viewing Student Records by Class and Course

The Records Manager allows teachers to review student records for an entire class on one screen and in several levels of detail. The pull-down menu, View Course Details, determines which level of detail of the specified course is shown on the screen. The study records for the Entire Course appear as the default. More detailed records can be viewed by selecting specific Units, Lessons, or Mastery Tests for that course. To switch courses, use the course pull-down list. See Switching Between Courses.

To view Placement Test records, select the Placement Test as a course from the course pull-down list. Indicate which test you want to see: Kids’ or General. See the Placement Test Guide for more information.

Understanding and Sorting Student Records

When viewing records for an entire course, or for specific units or lessons within a course, note the Tutor button at the bottom of the screen. The Intelligent Tutor provides feedback and suggestions regarding the study patterns of individual students and the class as a whole. Where available, you can access the Tutor by clicking the Tutor button at the bottom of the screen. See Intelligent Tutor.

There are several sorting options available for the data at each level. These are indicated by the headings in each column. To sort by the field of your choice, click on the appropriate heading. For example, to sort the records by total study time, click on the heading, Time.

Some of the sorting options include:

- **Student Name** - Sorts records by student names, alphabetically and numerically.
- **Time** - Sorts by the total time students have spent in the Entire Course or within the specified units or Lessons.
- **Module / Last Date** - Sorts by the most recent module, level or disc studied in the Entire Course view, or by the last date studied, in the Units, Lessons, or Mastery Test views.
- **M/S** - Sorts by the total number of modules (M) studied in the Entire Course view, or by the total number of sessions (S) studied in the specified Units or Lessons.
- **Complete** - Sorts by Completion Percentage, a measure of how effectively a student has studied a lesson. See The Completion Percentage. (Not available in the Entire Course view or in some older courses.)
• **Rank** - Sorts by class rank, which is based on the *Completion Percentages* for all units or lessons summarized on the screen being viewed. The highest ranked student will receive 100% and the other students’ scores will be normalized based on this curve. (Not available in the *Entire Course* view or in some older courses.)

• **Tests** - Sorts by the *average* of test scores in summary views, or by the last test taken when looking at specific Mastery Test scores.

Additional columns are viewable by clicking on the *arrow* to the right of the column headings (Windows) or using the *scroll bar* at the bottom of the screen (Mac). These additional headings allow the teacher to view and sort study details that can be used to evaluate how effectively students are spending their study time. It also allows teachers to make specific recommendations to help students study more effectively. These headings are:

• **Rep**: Repeat Button Usage. The number of Repeat Button clicks.

• **ABC**: ABC Button Usage. The number of ABC Button clicks. This is the text button.

• **Tra**: Translation Button Usage. The number of Translation Button clicks.

• **Mic**: Microphone Button Usage. The number of times a student clicked the Microphone Button.

• **Head**: Headphone Button Usage. The number of times a student clicked the Headphone Button to listen to their recorded voice.

• **Glos**: Glossary Usage Button. The number of times a student checked a Glossary screen.

• **SR-C**: Speech Recognition correct first time. This is the number of times a student was recognized as correct the first time when doing a Speech Recognition activity.

• **SR-A**: Speech Recognition attempts. SR-A is the number of times a student has attempted a Speech Recognition task. If SR-C / SR-A is high (>70%), the student has done well with the Speech Recognition exercises.

### Switching Between Courses

The *Records Manager* allows teachers to view records for all courses. In the course *pull-down* list, the teacher can choose which course to view, or select *All Courses*. To the right of the course name is the number of students in the class who have studied that course.

If a course isn’t registered or licensed to run with the *Records Manager*, you will see a ***. If a course hasn’t been studied by any of the students, the students will still be listed, but with dashes in all fields.
Understanding and Sorting Placement Test Records

The records and sorting options are different if the course being viewed is a Placement Test. The screen will display the name of the placement test (Kids’ or General) and the views of the data that are available will be: Placement Level (based on the combined data from Parts 1 & 2); Part 1 score only; or Part 2 score only.

In many cases, students will take only Part 1 of the test, since if their score is not high enough, they may not take Part 2. The reason that the Placement Test is in two parts is that for many students, taking Part 1 and Part 2 without a break makes the test more a test of concentration than a language test. At least a five-minute break between parts is recommended. For detailed information about the Placement Tests, please see the DynEd Placement Test Guide.

The information shown for the Placement tests is displayed according to the following headings:

- **Student Name** – Sorts student names alphabetically and numerically.
- **First Test** – Sorts by the first date the Placement Test was taken.
- **Level / Score** – Sorts by the Placement Level or by the score for each part of the test completed. Please see the Placement Test Guide for more information about the Placement Tests.
- **Last Test** – Sorts by the last date the Placement Test was taken (if it was taken more than once).
- **Level / Score** – Sorts by the Placement Level as determined by the last test, or by the score for each part of the test completed.
- **Change** – Sorts by the change in Placement Level or by the change in score for each part of the test, from the first testing to the last testing. Please note that meaningful change in Placement Level requires many hours of effective, frequent study between tests, particularly at higher levels. To test achievement over a shorter period of time, please use the Mastery Tests.

**Note:** Clicking the Tutor button at the bottom of the screen provides additional Placement Information for the student and class. Please see the section on the Intelligent Tutor for more detailed information.
Intelligent Tutor

The Intelligent Tutor provides information and recommendations about the study patterns of students. Based on an analysis of actual student usage and results in programs around the world, the Intelligent Tutor combs through the study data for each student and class as a whole and looks for key patterns that determine the effectiveness of language practice. For example, for students who need to improve their listening comprehension, improper use of the ‘text’ button in certain lessons works against their goal, so the Tutor will show the message: “Too much Text button compared to Repeat button.”

- When a teacher clicks the Tutor button, the Intelligent Tutor screen will appear as shown below.

![Intelligent Tutor Screen](image)

- If the Export button is clicked, a text file of messages shown on the screen will be created.
- If the More Detail button is clicked, further explanations will be shown.

For example, the comment: “Study too infrequent” will show: Students should study at least 3-4 times per week. Frequent study sessions are most effective.

By scrolling to the bottom of the Tutor window, additional information may appear which will help to determine when the next Mastery Test or Lesson will auto-unlock. Note: This additional information is shown only if you have highlighted a single student when clicking the Tutor button. Some messages only appear if the Study Path Manager is turned on.

For example:

- ‘Module 7 > Epidemic’ will not be unlocked by the Study Path Manager until you raise the Mastery Test score on ‘Module 6 > Life Experience > Mastery Test’ from 65 to over 85.
- ‘Module 3 > Our World > Mastery Test’ will not be auto-unlocked because the teacher has disabled it.

Using these comments, teachers can give specific advice to students about how to improve the effectiveness of their study. This ‘coaching’ is both motivating and highly effective.

- The Tutor is also useful for program Administrators who need to see how well the teachers are coaching their classes and whether further training is advisable to improve program results. Effective use of DynEd programs is beneficial to students, to programs, and to DynEd – so the Tutor has been developed as a means to improve the quality of the DynEd experience.

- The Intelligent Tutor has a scoring feature. The Study Score (SS) is an analysis of how well and how often students are using a course. It is based on study frequency, study activities, test scores, and comprehension as well as negative study patterns, such as inappropriate use of text support when developing listening comprehension.

For more information about the Intelligent Tutor and scoring, please see the Intelligent Tutor Guide. You can get updated documents at DynEd’s web site.
Viewing Individual Student Records by Lesson

In any view of class records, an individual student’s Study Records can be accessed by double-clicking the student’s name, or by highlighting the student’s name and clicking the *Select* button.

The student’s records are arranged by *module* or *levels* of the course, with sub-levels and individual lessons accessible by clicking on the *plus signs* (Windows) or *arrows* (Macintosh) next to each heading. At the deepest level, individual study sessions for each lesson are shown. To quickly open up to the deepest levels, hold down the *Ctrl* key (Windows) or the *Option* key (Macintosh) when opening up the levels.

The following information is displayed within the individual student records:

**Study Record Details**

- **Time** - The total number of hours and minutes spent in the module, unit, or lesson being viewed. This information is shown at all levels in the list, with the higher levels showing the sum of all levels below.

- **Complete** - The *Completion Percentage* value. This is a measure of how effectively a student has studied a lesson. See [The Completion Percentage](#) for more information. The Completion Percentage is shown for each unit and lesson studied, including the incremental values for each study session, which is at the deepest level of detail.

Note that Completion Percentages for each study session are summed and displayed at the top of the lesson in parentheses. However, where several lessons are grouped together below a higher level lesson, unit or module, the *Completion Percentage* for the entire group will be a weighted average [in square brackets], depending on the size and nature of the lessons. This is because some lessons can be completed quickly, while other lessons are much larger and will have a greater weight within the average.

![Image showing individual student records]

**Note:** The ratio between the Completion Percentage and the Time Studied indicates how well a student is using the program. The Completion Percentage value measures activity, but not time, so students who are not active in their study will have a lower Completion Percentage value for a lesson than students who have studied the lesson for the same amount of time but who are actively engaged with the program. See the Teacher’s Guides for each course for suggestions for improving study.
The following information is displayed:

- **Date & Time** - At the deepest level of detail, in addition to the above information, the date and time of the start of each study session is shown.

- **Score** - Two columns are shown under this heading. In lessons that include scored activities, the number in the first column is the most recent total score or percentage. A hyphen will be seen in this column if the particular lesson does not use scores. Maximum scores for different lessons can vary, and will often exceed 100. However, for Mastery Tests, the score is based on a scale of 0-100 (see the individual product Mastery Test Guides for more information).

  The second column of scores gives the number of correct answers or choices made out of the total number attempted. So, for a scored activity, a student may get a total score of 150 in the first column and 15/18 in the second column. That means they got 15 correct answers out of 18 questions, and their total score was 150.

- **Level** - This shows the student’s Shuffler Level at the end of each study session. The Shuffler Level is DynEd’s unique method for automatically adjusting the depth and variety of the material presented in a lesson. The higher the Shuffler Level, the more extensive the material being presented to the student. The Shuffler Level is also taken into account when calculating the Completion Percentage score. For more information, see Shuffler Level.

### Locked & Unlocked Lessons

The padlock icons to the right of lesson names indicate whether a particular lesson, group of lessons, or test is locked or unlocked. A red, closed padlock indicates that the lesson is locked and cannot be entered. A green, open padlock indicates that the lesson is unlocked and can be entered by the student.

Whether a lesson is locked or unlocked is controlled by the Records Manager. To lock or unlock a lesson for this student, you cannot do that from this screen. You must first click Back, then choose the student(s) from the class list and click on the Edit button at the bottom of the screen. Then select the lessons you wish to lock or unlock, and click the Lock or Unlock button. See Editing Student Data & Study Paths for more about this feature.

### Viewing Individual Student Records by Date

To see the complete study history for a student, click on the By Date button at the bottom of the Student’s Study Records screen. This view will arrange the records by date and time. Each row of data will show the lessons studied on a particular day, including the amount of time in each lesson and in each course. This view also shows the total time studied for each day.
Printing Student Records
To print the student records, go to the particular record screen view that you wish to print. This will determine the level of detail to be printed. Use the plus signs or arrows to open or close the levels of information you wish to display for printing.

Once the on-screen display is arranged as it should be printed, select Print from the File menu. A standard print dialog box will allow you to confirm the printing details. Click OK to print.

Viewing Study Records Offline using the Internet Records Manager
This feature (Online Version only) allows viewing of study records without the need of an Internet connection. This is especially useful if the Internet isn’t functional, or if the connection is slow. When using this feature, Internet records can only be viewed and not modified. Records may be manually or automatically synced at a later time. See Setting Up Automatic Synchronization of Local Records to Internet Records below for more information.

Sync All Student Records Now (Online Version)
The Internet Records Manager allows Administrators to coordinate or sync student records after a period of offline study. Students can study offline for a period of up to two weeks without having to connect to the Internet. When it is impractical for students to each connect to the Internet, the administrator at a site can use the Sync All Student Records Now utility to sync the records of all students at that site at one time. This utility is particularly useful when access to the Internet is limited.

To access this function, simply start the DynEd Internet Records Manager and select Sync All Student Records Now from the Options menu.

Setting Up Automatic Synchronization of Local Records to Internet Records
Local (offline) and Internet study records can be automatically synchronized. This is especially useful if the Internet isn’t functional, or if the connection is slow. Students can study offline with fast access to local records; records can then be synced every night using the synchronization utility.

Please contact DynEd customer support at support@dyned.com for more assistance on using this feature.

Using the Find Feature (Online Version)
The Find feature allows users to search their group or sub-group’s Internet records by student name, class name or student e-mail.
Extension Activities  (Video available on DynEd’s website)

Extension Activities provide teachers and language coaches with convenient access to targeted Session Plans, which include lesson-specific tasks, activities and worksheets. Also included are relevant sections of the Teacher Guides, for the lessons covered.

To access the Extension Activities select a student from a class, organize the view By Lesson or By Date, and then expand the units or Modules to show the main Lessons of the course.

Extension Activities are located within each Module or Unit. To view the available activities for a particular course, expand the Extension Activities list. Scores for completed or partially completed Extension activity sessions are provided under each lesson.

The picture icons shown to the right of the Lesson name indicate that an Extension Activity exists for a particular Lesson. Double-clicking the icon launches the Extension Activities into a new, resizable window (Internet connection required). Each Lesson might have more than one Session.

Sessions are organized into four tabs: **Session Plan, Tasks and Activities, Worksheets and Teacher Guides.**

- **Session Plan:** Session Plans provide the organizational core for the activities, and feature check boxes which allow instructors to “check off” completed items during each Session. Sessions are also timed, which is useful for keeping track of total study time for each session. Also, the timer serves as a key indicator for sessions where tutors are paid for their instructional services.

- **Tasks and Activities:** As both teacher and student make their way down the Session Plan list, Main Activities are discussed in detail under the “Tasks and Activities” tab. Activities that personalize and extend the content of the course to the life of the learner are featured. Typical activities include: self-introduction, verbal recitation, and counting. Ideally you should be able to complete all of the items in this Session within 15-20 minutes.

- **Worksheets:** The “Worksheets” tab provides immediate access to lesson-specific worksheets, documents or PowerPoint™ presentations. Here, learners can extend their study with written exercises and activities that can be printed or viewed on-screen. Clicking while holding Control shows the Internet address from where the worksheet is downloaded. This is extremely useful for Internet study sessions where copying and pasting the file link is necessary.

- **Teacher Guides:** This tab accesses specific pages from the Teacher Guides, which features the main learning points and concepts discussed within each lesson. This represents a readily accessible, time-saving resource for the teacher.
Extension Activities Records:
When you are done with the session, click **Complete** and you will be asked to grade the student or class (a score of 0-100). The Extension Activities window will close and the score will be included in the study records.

To view the records by date, click **By Date** on the Records Manager main window. A new entry will appear for the completed Extension Activities Session.

To view the records by Lesson, click **By Lesson** on the Records Manager main window, open a Module and the desired Extension Activities line.

Follow-Up Sessions:
To continue a previous Session, navigate to the **By Date** screen and double-click the Lesson containing the Session. If the student received a passing score on the first Session, the next Session will come up (see the pull-down menu at the bottom of the screen). If a passing score is not achieved, the same Session will appear when the Extension Activities is launched.

**Study Scores (SS) and Weighted Study Scores (WSS)**

**List of Students**
A **Study Score** (SS) is a measure of how well and how often a student is using a course. It is based on study frequency, study activities, test scores, and comprehension as well as negative study patterns, such as inappropriate use of text support when developing listening comprehension. Please see the Intelligent Tutor Guide for more information about study scores.

- By using the **Tutor** button, the teacher and student can see individual SS values.
- Negative study scores will show in red, and positive study scores will show in black.

The **Weighted Study Score** (WSS) is the weighted average of a student’s study scores for all courses. The weighting is based on the amount of time that a student studies each course, putting more emphasis on courses that are studied more.

- **Qualified Students:** (Appear in black at the top of the list):
  - Have studied in the last 30 days and
  - Are not deleted, expired or disabled.
- **Unqualified Students:** (Appear in grey at the bottom of the list):
  - Have not studied in the last 30 days or
  - Are deleted, expired or disabled.
List of Classes
• Here, the WSS is the average of the weighted study scores for all qualified students in the class. Unqualified classes will show the WSS in grey.
  o Qualified Classes:
    ▪ Have five or more qualified students. Your sales rep can customize this value.
  o Unqualified Classes:
    ▪ Are not counted in the group's WSS.

List of Groups: (Internet Records only)
• In the List of Groups screen, the WSS is the average of the weighted study scores for all qualified classes in the group.
Import-Export Tools

The Import-Export tools of the Records Manager are located under the *File* pull-down menu at the top of your screen. These tools provide additional flexibility for managing and analyzing the data.

### Import Student Names

This function allows teachers to import a list of names and other information that has previously been prepared in a file outside the *Records Manager*. This file must be a standard text file, with entries in the following format: **name <TAB> e-mail address <TAB> password**. For example, if a class list has already been prepared in this format, then it can be imported into a Class so that the teacher doesn’t need to re-enter the data.

**Export Student Names**

This function allows teachers to export a list of names and e-mail addresses from a Class List into another file for use in a standard word processing application.

### Export Student Data

For users with an external record-keeping system or who want more flexibility in the organization or analysis of student records, records can be exported from the *Records Manager*. DynEd does not guarantee the compatibility of this information for any particular purpose nor do we promise to provide support for its use. The fields that are exported may change from time to time although generally such changes are limited to the addition of new fields at the end of the record.

To export all data from the student records into a text file, select one or more students from the class list and choose **Export Student Data** from the *File* menu. A standard file save dialog box will appear, allowing you to specify the name and location of the export file that will be created.

The *Records Manager* exports student records in a tab-delimited format (i.e., with each field separated by a TAB character). This format allows the records to be easily imported into a spreadsheet or database such as Microsoft Excel or FileMaker Pro.

If you try to view this exported information in its raw form, you may find that the information is not easy to read. This is because it consists of a large number of fields of detailed information for each record, including some fields that are not displayed in the *Records Manager*. For more information about the fields that are included when exporting, see the Appendix, *List of Exported Fields*.

### Export This Screen

To have greater control of the information to be exported, use the **Export This Screen** menu option. First, go to *View Course Details*. You can then select specific *Modules, Units, Lessons* or *Mastery Tests* to view. Once the information you wish to export is displayed, choose **Export This Screen** from the *File* pull-down menu.

Please refer to the Appendix, *List of Exported Fields*, for specific field names and their purpose. These fields provide information helpful in assessing whether the students are taking full advantage of the learning tools.
Administrator Options

To locate the Administrator Options, go to the Options pull-down menu at the top of your screen.

These options help schools and other institutions manage and integrate the study records into their existing systems. They also provide a means to track how the courses are being used at different sites.

Records Manager Options

The first option allows the Administrator to require that the Administrator password be used when adding, editing, or deleting new classes on the system. The second option allows the Administrator to require that the Administrator password be used when adding, editing, or deleting new students on the system. The last option allows the Administrator to lock and unlock lessons. Note: Internet Records users should go to the Group Listing screen, and click Edit.

Set Begin/End Date

Administrators can choose to display student study records for a given period. Only study information from the period set in the Set Begin/End Date option will be displayed. If this is a Networked installation, this setting affects all teachers using the Records Manager. If this is a stand-alone installation, this setting only affects users utilizing the Records Manager on a single machine.

To display study records for all installed courses, the Administrator can select All Courses from the course selection drop-down list box.

View Active Students

This option allows the Administrator to clear inactive students from the network so that new students can log-in. It shows the names of all active students, and shows “not active” for students who may have logged-off incorrectly. To clear the system, click the Reset button.

Change Administrator Password

This option allows Administrators to change their password, which controls access to the Records Manager Options and to all class records. If this password is lost or forgotten, a new password must be set-up by using the Advanced Installation Options while running the Setup program on the DynEd Installation Disc CD-ROM.

Backup Student Data

This option allows Administrators to back up the \DynEd\Data folder which holds the student records for all classes. The backed-up data is stored in the \DynEd\Backups\(today’s date)\data folder.

Setting up a Backup Data Reminder (Local Version)

When the Local Records Manager is run for the first time, users are given the option of setting a backup date for their student data. The default backup interval is every 14 days, and can be modified.
Product Updates (Local Version)

This option will check all installed DynEd courses and programs for updates. If updates are available, the Records Manager will close automatically and the DynEd UptoDate program will launch. An Internet connection is necessary to use this option.

Merge Databases

The Merge Databases option (not available in the Internet version) allows the merging of student records from the Records Managers of several different sites into a centralized Records Manager.

Procedure for Merging a Single External Records Manager Database into Your Records Manager - This example shows how an organization in Rome can merge the student records from a Records Manager at a second site in Milan into their Records Manager in Rome.

Procedure at the External Site (Milan)
1. Locate the “Data” folder within the “dyned” folder. This folder contains the relevant Records Manager files for merging.
2. Copy the “Data” folder and save it in a convenient location, such as the (Milan) system desktop.
3. Create a folder on the local system with an informative name, such as “MilanData.”
4. Move the “Data” folder created in step 2 into the “MilanData” folder created in Step 3.
5. Send the “MilanData” folder to Rome. (For example, zip-up the “MilanData” folder and send it to Rome via email or ftp.)

Procedure at Central Site (Rome)
1. Open the Records Manager and select Merge Databases from the Administrator Options menu. A browser window will open to allow you to choose the external Data folder you wish to merge into your own Records Manager records.
2. Navigate to the location where the unzipped “MilanData” folder is, select it, and click OK.

Procedure for Merging Multiple External Records Manager Databases into Your Records Manager - This procedure can be followed to merge the databases from a number of other locations into your central Records Manager.
1. Each external site should follow the same procedure as described above in Procedure at External Site (Milan) to send their data folders (MilanData) to the Central Site (Rome).
2. At your Central site, create a new folder called “MergeDB” in a convenient location. This exact name, without the quotation marks must be used for this folder.
3. Move all of the external folders, such as MilanData, into the MergeDB folder.
4. Select Merge Databases from the Administrator Options menu in your Records Manager. A browser window will open to allow you to choose the external Data folder you wish to merge into your own Records Manager records.
5. Navigate to the location where the “MergeDB” folder is, select it, and click OK.

Note: The Merge Databases option works from the Class Selection screen. It will not work if you are viewing Class Records for a specific class.

Automatic Batch Merging - In special cases, where there are DynEd databases at several sites which need to be merged regularly, automatic batch merging may be convenient. The DynEd Management System can automatically merge multiple DynEd databases from several sites with only one request. Institutions with batch merging needs should contact Dyned International for further information and technical support.
Setting Monitor Passwords (Online Version)

It is possible to give access to the Records Manager using a Monitor password. The Monitor login allows access to all class records within a group without the need for individual class passwords. This is a read-only capability, as no changes are allowed.

Setting up Demo and Placement Test Classes

A Demo Class allows access to any course at no charge for training or sales purposes. A Placement Test Class allows students to take only the Placement Tests. Students in a Placement Test Class have no access to other courses until they are transferred into a regular class. A class which is marked both Demo and Placement Test will allow students to take the Placement Test and not be billed until they are transferred into a regular class. (Note: To set up either a Demo Class or a Placement Test Class, hold Ctrl and click the Edit button in the Class Selection Screen.)

Setting Expiration Dates for Classes (Online Version)

For multiple classes within the same group, Expiration Dates can be set on a per-class basis. This allows classes to expire at a date set by the Administrator. To do this, hold Ctrl and click the Edit button in the Class Selection Screen.)
E-mail Options

To locate the E-mail Options, go to the Options pull-down menu at the top of your screen.

These options help teachers work with students studying at a distance, provide school managers with usage logs to monitor how courses are being used at different sites, and provide technical information for support purposes. These e-mail options may be disabled by the Administrator through the Administrator Options/Records Manager Options.

Import E-mailed Student Records (Online Version)

If students have e-mailed their Student Records, these records can be imported into the Records Manager by using the Import E-Mailed Student Records option. Go into the class into which you wish to import the data. Select Import E-Mailed Student Records from the Options menu. A browser window will open and prompt you to select the folder in which relevant e-mail attachments are located.

**Note:** Depending on the type of e-mail application you use, you may need to save the attachments into their own folder. If you are not sure about your e-mail application, please consult with the person in your organization responsible for installing e-mail on your system.

**Eudora:** Attachments are automatically separated from the e-mail and saved in their own Attachments folder.

**Outlook:** Attachments are imbeded within the e-mail. To import them, they must first be saved as a file into their own folder. Create a folder, such as “DynEd Data Attachments Folder,” and save all of your student record attachments here.

E-mail Technical Log File to DynEd International

The DynEd Management System records various technical aspects of your DynEd installation, including version numbers, installation profiles, and other details that can aid our engineers in trouble-shooting any technical problems you may have. This record is kept in a file called Dyned.log.

Should you experience technical difficulties with your DynEd installation, your distributor can generally provide solutions. If these do not solve your problem, you may be asked to e-mail the DynEd Technical Log File to DynEd’s engineers to help troubleshoot the problem.

To e-mail this file, simply select E-mail Technical Log File to DynEd International from the Options/E-Mail Options menu. You may also write a message in the space provided to describe the technical problem you are experiencing. Then click the OK button, fill out your e-mail and SMTP Host information and Send.

E-mail ‘Getting Started’ Instructions to Students (Online Version)

This option allows class Administrators to send ‘Getting Started’ instructions to either an entire class or to selected students within a class. These instructions help students download the DynEd program, whether or not they have a DynEd Installation CD. Student Name, Student E-mail, and Student Password are included by default, but may be removed from the e-mailed instructions to protect privacy.

To access this function, simply start the Internet Records Manager and select E-mail ‘Getting Started’ Instructions to Students from the Options/E-Mail Options menu.

E-mail ‘Getting Started’ Instructions to the Teacher (Online Version)

This provides class Administrators with the option to send ‘Getting Started’ instructions to the teacher(s). These instructions help the teacher(s) download the Records Manager. User ID, Password, Teacher Name, Class Name, and Teacher Password are included by default, but may be removed from the e-mailed instructions.
To access this function, simply start the Internet Records Manager and select **E-mail ‘Getting Started’** from the Options/E-Mail Options menu.

**Sending E-mail to Students**

The Send E-mail feature allows teachers to send e-mails to either an individual student or an entire class.

**Sending Messages to Students and Teachers (Local Version)**

Students and teachers can exchange messages using the built-in messaging feature. This feature is available only for network installations.
Appendix A - The DynEd Management System

The DynEd Management System includes the Records Manager, the License Management system, technical support functions, and a variety of advanced features which help schools and other institutions to effectively manage the installation, student registration, testing and record keeping for DynEd products. These capabilities can be utilized in a variety of alternative configurations:

**Stand-Alone Systems**

<table>
<thead>
<tr>
<th>Study Records stored locally on the computer hard drive</th>
<th>Course Content on CDs or installed onto the HD with a Discless license.</th>
</tr>
</thead>
</table>

**Networked Systems**

<table>
<thead>
<tr>
<th>Study Records stored on a network file server</th>
<th>Course Content on CDs or installed onto the HD of each client with a Discless license.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Study Records stored on a network file server</td>
<td>Course Content installed onto the network file server with a Discless network license</td>
</tr>
</tbody>
</table>

**Distance Education Model**

<table>
<thead>
<tr>
<th>Study Records stored on Internet. Student must have an Internet connection. Teacher logs on to the Internet to view and manage records with the Records Manager.</th>
<th>Course Content on CDs or installed onto the HD of each client with a Discless license.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Study Records stored on a network. Students e-mail their records to teacher with Records Manager. Teacher imports e-mailed records to class list in Records Manager.</td>
<td>Course Content on CDs or installed onto the HD of each client with a Discless license.</td>
</tr>
</tbody>
</table>

**Franchise Education Model**

<table>
<thead>
<tr>
<th>Study Records stored on Internet or on school network. Students study on school network or at home if they have an Internet connection.</th>
<th>Course Content on school network and on CDs or HD of each client with a Discless license.</th>
</tr>
</thead>
</table>

- Student e-mails records to school with Records Manager or logs on to the Internet to sync records and update study license.
- Teacher imports e-mailed records to class list in Records Manager on school network or logs on to the Internet to access the Records Manager.
- Records from each school are: sent to the central site and merged; or accessed on the Internet by the central site (which may view and manage all school records with the Records Manager.)
- Usage data for each school is sent to the central site on a regular basis via the Records Manager.

For advantages and disadvantages of these configurations, please contact your DynEd dealer or representative, or check DynEd’s web site at [http://www.dyned.com](http://www.dyned.com)

**Discless Licensing System**

DynEd’s Discless Licensing System controls the installation and operation of DynEd courseware over networks (without the need for students to each have a CD). When ordering DynEd products for Discless operation, you need to order a Discless License. A License Certificate is issued for each DynEd product and allows a specific number of students to use the product simultaneously. Discless licenses are generally issued for a complete course or series. However, individual modules within a course can also be licensed. In addition, time-limited licenses can be created with durations in units of months. Please contact your DynEd dealer for more information about licensing options.
Appendix B - License Management

The DynEd Management System allows products to be installed to a server and configured to operate in various ways, such as discless operation for 100 students for six months. This is controlled through a system of licenses.

When you receive a DynEd course, you will receive a unique installation code for your course and the license specifications for its operation. In cases where you have multiple licenses, it is important to understand what each license does. This information can be viewed in the License Management screen which is accessible in the Options pull-down menu after you enter the Records Manager. See Registration.

On this screen, you can view any of your licenses by selecting them from the list in the top left box. Selecting a license causes its relevant information to display below.

If you select a license that has not yet been registered, you can use this screen to complete the registration process.

**Note:** For all network installations, and all installations of the Records Manager, the licensing system uses three codes which all work together to enable the courseware. The first is the **Installation Code** which is unique to your order and which describes the options you have licensed. After this code is entered during the installation process, a **Confirmation Code** is generated which verifies that the installation has been completed correctly. Then the product must be registered by getting and entering a **Registration Code**. See Registration. Once the registration has been completed, the product is ready for use.

**Multiple Licenses** — It is possible to have more than one license for the same course. For example, a school might purchase a 20-user license for a course and later add a 60-user license as their needs increase. The net result would be the ability to have up to 80 users running the course simultaneously. As in this example, the licenses are additive, so that the allowable number of students is equal to the combined numbers from all installed, unexpired licenses.
Appendix C – Tracking Performance

The Completion Percentage

The learning of a second language should be approached as a skill to be acquired, and not merely an 'understanding' of grammar rules and vocabulary. Successful language learning requires 'overlearning' and considerable focused practice through a cycle of preview, comprehension, practice, and review.

The Completion Percentage is shown in the student records. It is a measure of how thoroughly a student has studied and practiced each lesson. A 100% Completion Percentage means that the student has completed the recommended amount of study for a lesson or group of lessons.

<table>
<thead>
<tr>
<th>Completion Percentage</th>
<th>Symbol</th>
<th>Mastery Test Scores</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1-79</td>
<td>☐</td>
<td>1-84</td>
<td>☐</td>
</tr>
<tr>
<td>80-100+</td>
<td>☑</td>
<td>85+</td>
<td>☑</td>
</tr>
</tbody>
</table>

As shown in the table above, the Records Manager now features a set of distinct symbols which can be used to quickly judge a student’s performance in either the lessons or the Mastery Tests.

To assist students in reaching the goal of communicative competence, the Completion Percentage sets completion goals based on the following study activities: sentence repetitions, sentence recording attempts, speech recognition attempts, use of the glossary, and the number of questions which are answered correctly.

The program counts each time a student listens to a sentence, uses the repeat button to repeat a sentence, uses the record button to record a sentence, consults the glossary, completes a speech recognition task, and answers a question. The accumulated data is analyzed and scored according to the length of the lesson, the number of sentences and questions in a lesson, and the kinds of activities which are appropriate in that lesson.

To reach the desired level of mastery of the materials provided within DynEd’s courses, and to attain an 80% or more Completion Percentage, students should preview each part of a lesson, pay attention to different grammar and vocabulary areas, consult the Glossary (if available), practice saying and recording the sentences, and review each lesson over a period of several study sessions. If this is done, the vocabulary and basic grammatical patterns will be successfully acquired (not just memorized short term), and the Completion Percentage will indicate when the student should be prepared to successfully take the Mastery Test, if available for that lesson, or move on to other lessons.

Adjusting the Completion Percentage

In general, the Completion Percentage is a relative measure of the quality and depth of study a student has completed in lesson as compared to a baseline student with no prior English study whose native language is dissimilar to English. This hypothetical student may or may not be comparable to the actual students one is teaching, so provision is made within the Records Manager for adjusting the Completion Percentage.

The Completion Percentage calculation may be adjusted by a teacher if the levels seem too high or too low for the class average or for groups of students within a class who have placed at a different level from the average but are required to study at the same level. This is done by adjusting the Recommended Study Time slider in the Class Set-up screen. (See Adding or Editing a Class.) This setting applies to the entire class. There is no provision for adjusting the setting on a student-by-student basis. In situations where different settings are desirable for groups of students within a class, the teacher can subdivide the class so that each subclass has a different setting.
different settings are desirable for groups of students within a class, the teacher can subdivide the class so that each subclass has a different setting.

**Shuffler Level**

Also shown in the student records, the *Level* refers to DynEd’s proprietary *Shuffler* mechanism. The *Shuffler* is DynEd’s unique method for automatically adjusting the depth and variety of the material presented in a lesson. As a student answers questions, the *Level* is adjusted up or down, depending on the success rate of the student. The maximum *Level* is 3.0, which means that the lesson is fully open.

This means of control restriction helps avoid overloading students with too much information or with tasks beyond their ability. As students become comfortable with the material and begin responding successfully, the *Level* automatically rises, and additional material, generally with more difficult grammar and vocabulary, is opened up to the students. Should the student begin to have trouble at a higher *Level*, the *Level* will automatically fall, allowing students to focus on a more limited selection of the material before opening up the rest of the lesson. The actual effect of the *Shuffler* varies from lesson to lesson and course to course.

**Details of the Completion Percentage Calculations**

The *Completion Percentage* figure provides a measure of three principal factors of student usage of DynEd’s programs:

- Number of phrases heard and repeated, the number of SR attempts, the number of times a student records and monitors their speech, and usage of the Glossary,
- Percentage of correct answers
- *Level* at which the student is studying the lesson

**Completion Percentage Formula** — Here is the formula used for the *Completion Percentage* (Mastery) calculation:

\[
\text{Percent Complete} = \frac{(\text{PC}_\text{Value1} + \text{Point}_\text{Value2}) \times 100}{\text{Teacher Weighting}}
\]

\[
\text{PC}_\text{Value1} = \left(\frac{\text{Phrase Target} - \text{Phrase Actual}}{\text{Phrase Target}}\right) \times \text{Phrase Actual}
\]

\[
\text{PC}_\text{Value2} = \left(\frac{\text{Questions Target} - \text{Questions Actual}}{\text{Questions Total}}\right) \times \text{Questions Actual}
\]

Note: Phrases get a higher point value at a higher Shuffler Level. Each Glossary screen that a student refers to during the study of a lesson (up to a maximum of 10) counts as one Phrase Count. Time Elapsed does NOT affect the Completion Percentage.

**Targets Weighting** — If the “Targets Weighting” is 70, then PC_Value1 ("Phrase Count" + "SR Attempts" + "Microphone Button") will be 70% of the *Completion Percentage* figure, and PC_Value2 ("Questions Correct") will be 30% of the total *Completion Percentage* calculation.

“Target Weighting” is a rough estimate on the part of the author as to the relative importance of phrases heard and accuracy (in answering questions and doing exercises correctly) for a particular lesson. This balance between the importance of comprehension and accuracy varies depending on the nature of the lesson. For a *Presentation* section, for example, where comprehension is the initial focus, the “Target Weighting” would emphasize phrases heard (Phrases_Actual), while for a *Focus Exercise* accuracy (Questions_Actual) would be weighted more heavily.

Note: Since the Completion Percentage is a measure of how much the student has studied relative to the targets set by the author for each lesson, students who study beyond the target levels will have Completion Percentage scores in excess of 100%. 
**Teacher Weighting** — "Teacher Weighting" is controlled by the slider in the *Recommended Study Time* field. This is accessed when viewing a class of students in the *Records Manager* by clicking on the *Edit* button at the bottom of the screen. Moving the slider to the left decreases the number of phrases or correct answers required for the student to reach the specified *Completion Percentage* figure. Moving the slider to the right increases it.

The actual *Completion Percentage* figure required for the automatic opening of *Mastery Tests* can be controlled by the teacher, as well, by entering a new % target figure in the field at the bottom left of this screen. Both of these changes affect all students in the class. In order to individualize the settings for specific students, such students should be entered into a separate class.

**Viewing the Adminlog file**

The Adminlog.txt file is automatically updated each time the Records Manager is run. This log file keeps track of class and group information each time a student is added, edited or deleted. The Adminlog.txt file is stored in the DynEd installation directory on the local server.
## Appendix D - List of Exported Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-7</td>
<td>User variables</td>
<td>Can be set by users for special purposes</td>
</tr>
<tr>
<td>8</td>
<td>Course Number</td>
<td>The DynEd Product ID Number</td>
</tr>
<tr>
<td>9</td>
<td>Course Name</td>
<td>Title of the course</td>
</tr>
<tr>
<td>10</td>
<td>Class ID</td>
<td>8 character internal ID code of class</td>
</tr>
<tr>
<td>11</td>
<td>Class Name</td>
<td>Name assigned when class was created</td>
</tr>
<tr>
<td>12</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Teacher Name</td>
<td>Name assigned when class was created</td>
</tr>
<tr>
<td>14</td>
<td>Student ID</td>
<td>8 character internal ID code of student</td>
</tr>
<tr>
<td>15</td>
<td>Student Name</td>
<td>Name assigned when student was created</td>
</tr>
<tr>
<td>16</td>
<td>Record Number</td>
<td>Identifying number for this study record</td>
</tr>
<tr>
<td>17</td>
<td>Module Number</td>
<td>1-character ID of current module (section of the course)</td>
</tr>
<tr>
<td>18</td>
<td>Module Name</td>
<td>Name of current module (section of the course)</td>
</tr>
<tr>
<td>19</td>
<td>Lesson Number</td>
<td>1-character ID of current lesson within the module</td>
</tr>
<tr>
<td>20</td>
<td>Lesson Name</td>
<td>Name of current lesson within the module</td>
</tr>
<tr>
<td>21</td>
<td>User variables</td>
<td>Can be set by users for special purposes</td>
</tr>
<tr>
<td>28</td>
<td>Start Date</td>
<td>Date study session was started</td>
</tr>
<tr>
<td>29</td>
<td>Start Time</td>
<td>Time study session was started</td>
</tr>
<tr>
<td>30</td>
<td>Time</td>
<td>Number of Minutes spent in study session</td>
</tr>
<tr>
<td>31</td>
<td>Score</td>
<td>Lesson score (some lessons display this value)</td>
</tr>
<tr>
<td>32</td>
<td>Level</td>
<td>Shuffler Level at end of lesson</td>
</tr>
<tr>
<td>33</td>
<td>Shuffler Locked</td>
<td>Obsolete</td>
</tr>
<tr>
<td>34</td>
<td>Encounters</td>
<td>Obsolete calculation of student activity</td>
</tr>
<tr>
<td>35</td>
<td>Questions Total</td>
<td>Total number of questions asked in study session</td>
</tr>
<tr>
<td>36</td>
<td>Questions Correct</td>
<td>Number of questions answered correctly in study session</td>
</tr>
<tr>
<td>37</td>
<td>ABC Button</td>
<td>Number of times this button was pressed</td>
</tr>
<tr>
<td>38</td>
<td>Translation Button</td>
<td>Number of times this button was pressed</td>
</tr>
<tr>
<td>39</td>
<td>English Button</td>
<td>Number of times this button was pressed</td>
</tr>
<tr>
<td>40</td>
<td>Microphone Button</td>
<td>Number of times this button was pressed</td>
</tr>
<tr>
<td>41</td>
<td>Headphone Button</td>
<td>Number of times this button was pressed</td>
</tr>
<tr>
<td>42</td>
<td>SR Attempts</td>
<td>Number of times a Speech Recognition (SR) was attempted</td>
</tr>
<tr>
<td>43</td>
<td>SR Correct First Time</td>
<td>Number of times an SR attempt was recognized the first time</td>
</tr>
<tr>
<td>44</td>
<td>Glossary Used</td>
<td>Number of times a glossary screen was viewed</td>
</tr>
<tr>
<td>45</td>
<td>Phrase Count Single</td>
<td>Number of phrases heard (not multiplied by Shuffler Level)</td>
</tr>
<tr>
<td>46</td>
<td>Phrase Length</td>
<td>Total length of phrases heard in seconds</td>
</tr>
<tr>
<td>47</td>
<td>Phrase Count</td>
<td>Number of phrases heard (multiplied by Shuffler Level)</td>
</tr>
<tr>
<td>48</td>
<td>History Version</td>
<td>Identifies each generation of history field layout</td>
</tr>
<tr>
<td>49</td>
<td>Phrase Target</td>
<td>Target value for phrases set by the author for this lesson</td>
</tr>
<tr>
<td>50</td>
<td>Questions Target</td>
<td>Target value for questions set by the author for this lesson</td>
</tr>
<tr>
<td>51</td>
<td>Targets Weighting</td>
<td>Author’s ratio of emphasis on listening vs. accuracy</td>
</tr>
<tr>
<td>52</td>
<td>Teacher Weighting</td>
<td>Position of the “Recommended Study Time” slider in the RM</td>
</tr>
<tr>
<td>53</td>
<td>Completion Percentage</td>
<td>Calculated Completion Percentage (includes Teacher Weighting)</td>
</tr>
<tr>
<td>54</td>
<td>Lesson Id</td>
<td>Unique Lesson ID</td>
</tr>
</tbody>
</table>

Copyright © 1998-2004 DynEd International, Inc. All rights reserved.
1. **NOTICE.** DYNED INTERNATIONAL, INC. ("DYNED") IS WILLING TO LICENSE THE ENCLOSED SOFTWARE TO YOU ONLY ON THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS LICENSE AGREEMENT. PLEASE READ THIS LICENSE AGREEMENT CAREFULLY BEFORE CONTINUING. BY CLICKING ON THE "I ACCEPT" BUTTON, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THESE TERMS DYNED IS UNWILLING TO LICENSE THE SOFTWARE TO YOU, AND YOU SHOULD CLICK ON THE "I DO NOT ACCEPT" BUTTON TO EXIT. IN SUCH CASE, PROMPTLY RETURN ANY AND ALL DYNED MATERIALS, ALONG WITH PROOF OF PAYMENT, TO THE AUTHORIZED DEALER FROM WHOM YOU PURCHASED FOR A FULL REFUND OF THE PRICE YOU PAID.

2. **Ownership and License.** This is a license agreement and NOT an agreement for sale. DynEd continues to own the copy of this Software contained in this package and all other copies that you are authorized by this Agreement to make (the “Software”). Your rights to use the Software are specified in this Agreement, and we retain all rights not expressly granted to you in this Agreement. Nothing in this Agreement constitutes a waiver of DynEd's rights under U.S. Copyright law or any other federal or state laws or the Copyright laws or any other applicable laws of other nations.

3. **Permitted Uses.** You are granted the following rights to the Software:

   (a) **Right to Install and Use - Standalone Computer version.** You may use the Software from any single CD-ROM on one and only one compatible computer at a time. You may not use any circumstance use the Software from a single CD-ROM simultaneously on two or more computers. You must license an additional copy of the Software for each additional compatible computer on which you want to use the Software from a single CD-ROM concurrently.

   (b) **Right to Install and Use - Network version.** You may install and use the Software on a single file server for use on a single (local or wide area) network with the Software working simultaneously on up to the number of work-stations indicated on the License Certificate. If you wish to use this Software on more than one network, or on a network with the Software working simultaneously on more than the number of workstations specified in the License Certificate, you must license additional copies of the Software.

   (c) **Right to Transfer.** You may not lend, rent or lease this Software without the express written consent of DynEd. However, you may transfer this license to use the Software to another party on a permanent basis by transferring this copy of the Licensing Agreement, the original Software, and all documentation. Such transfer of possession terminates your license from DynEd. Such other party shall be licensed under the terms of this Agreement upon its acceptance of this Agreement by its initial use of the Software. If you transfer the Software, you must remove from your computer any copy of the Software you may have made and you may not retain any such copies of the Software for your own use.

4. **Prohibited Uses.** You may not, without written permission from DynEd:

   (a) Use, copy, modify, merge, or transfer copies of the Software and any accompanying documents except as provided in this Agreement;

   (b) Disassemble, decompile or "unlock", reverse translate or engineer, or in any manner decode the Software for any reason; or

   (c) Sublicense the Software.

5. **Limited Warranty.** We make the following limited warranties, for a period of ninety (90) days from the date you acquired the Software from DynEd or its authorized dealer:

   (a) Media. The CD-ROM(s) and documentation in this package will be free from defects in materials and workmanship under normal use. If the CD-ROM(s) or documentation fail to conform to this warranty, you may, as your sole and exclusive remedy, obtain a replacement free of charge if you return the defective discs or documentation to DynEd with a dated proof of purchase.

   (b) Software. The Software in this package will materially conform to the documentation that accompanies it. If the Software fails to operate in accordance with this warranty, you may, as your sole and exclusive remedy, return all of the Software and documentation to the authorized dealer from whom you acquired it, along with a dated proof of purchase, specifying the problem, and DynEd, at its option, will provide you with either a new version of the Software or a full refund.

   (c) Warranty Disclaimer. DynEd does not warrant that this Software will meet your requirements or that its operation will be uninterrupted or error-free. DynEd excludes and expressly disclaims all expressed and implied warranties not stated herein, including the implied warranties of merchantability and fitness for a particular purpose. (These warranties give you specific legal rights, and you may also have other rights which vary from jurisdiction to jurisdiction. Some jurisdictions do not allow the exclusion or limitation of implied warranties, so the above exclusion or limitation may not apply to you. In that event such warranties are limited in duration to the warranty period. No warranties apply after that period.)
6. **Charges and Taxes**. DynEd does not give refunds or credits for charges already due or paid. If any authority imposes a duty, tax, levy or fee, excluding those based on DynEd's net income, upon the Software supplied by DynEd under this Agreement, then you agree to pay that amount as DynEd specifies or supply exemption documentation.

7. **Limitation of Liability**. DynEd's liability to you for any losses shall be limited to direct damages, and shall not exceed the amount you originally paid for this Software. In no event will DynEd be liable for any special, incidental, or indirect damages or for any economic consequential damages (including lost profits or savings), even if DynEd, or its reseller, has been advised of the possibility of such damages. Some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you.

8. **Disclaimer of Liability for Hosting in DynEd Servers**. DynEd disclaims all liability for any and all damages, including direct, consequential and incidental damages, arising out of the failure or inability of DynEd to maintain access to the DynEd servers in accordance with this agreement, including, but not limited, losses or damages resulting from the loss of your business, loss of data or service as the result of delays or service interruptions.

9. **United States Government Restricted Rights**. The enclosed Software and documentation are provided with Restricted Rights. Use, duplication or disclosures by the U.S. Government or any agency or instrumentality thereof is subject to restrictions as set forth in subdivision (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at 48 C.F.R. 227-7013, or in subdivision (c)(1) and (2) of the Commercial Computer Software - Restricted Rights Clause at 48 C.F.R. 52-227-19, as applicable. Contractor Manufacturer is DynEd International, Inc., 1350 Bayshore Hwy., Suite 850, Burlingame, CA 94010.

10. **Export Controls**. You agree that you will not directly or indirectly transfer the Software or documentation to any country where such transfer would be prohibited by the U.S. Export Administration Act and the regulations issued thereunder.

11. **Termination**. This license and your right to use this Software automatically terminates if you fail to comply with any provisions of this Agreement, destroy the copies of the Software in your possession, or voluntarily return the Software to DynEd. Upon termination you will destroy all copies of the Software and documentation.

12. **Miscellaneous Provisions**. This Agreement will be governed by and construed in accordance with the substantive laws of the state of California. This is the entire agreement between you and DynEd relating to the contents of this package, and supersedes any prior purchase order, communications, advertising or representation concerning the contents of this package. No change or modification of this Agreement will be valid unless it is in writing and is signed by DynEd. The governing language of this agreement shall be English.